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Begin With the End in Mind

Black & White or Color
Including color pictures in your family history will really make it special. Unfortunately, it 
will also make your bill especially painful. Color costs more. It is possible to print most of 
the book in black & white with just a few well chosen pictures in color. The least expensive 
way is to give up the idea of color and have the entire book printed in black & white.
If you scan the photos yourself be sure you scan them at a print quality resolution. (See 
the Scanning Basics section.) Scan the pictures you intend to be color in color. Scan those 
pictures that will be printed in black and white as grayscale.

Finished Size
Decide what size (height and width) you want your book to be before you begin. The 
two least expensive sizes for your book are letter size (8.5x11) and half a letter size sheet 
(5.5x8.8).  Other sizes are possible but will add to the expense of the book. All software 
programs let you choose your paper size. You may need to create a new custom size if you are 
not using letter size. Don’t worry about pagination. Pagination is the placing or rearranging 
of pages for print. The press has software that does that easily. If you try to do it yourself and 
do it wrong, prepress will have to straighten it out.

Fonts
The most important requirement for fonts is that they be easily readable. Something too decorative 

is difficult to read.  Confine those fonts to the title page. ALL CAPITOLS IS ALSO HARDER 
TO READ. They’ve done studies. Its just how the brain works.
Most software has a default font. This is a common, easy to read font that will work for most 
things. If you stick with that font you can be sure the press will have it on their computers. 
If you want to use another, less common font, you will need to plan ahead. Here are some 
options. You can call the press and ask if the font you want to use is available on their 
computers. You can put the font on your disk and bring it to the press with the finished file. 
You can save the finished document as a pdf file and eliminate the whole issue. ( See The 
Joys of PDF under Digital Workflow.) Or, if you have a nice printer, you can make a hard 
copy and bring it in to be scanned. (But PLEASE, see the Cut & Paste section.)

Margins
No matter what type of binding you choose, binding takes space. Be sure to leave good 
margins on all sides. The most common software choices give you an inch or an inch and a 
half by default. The easiest thing to do is just leave it at that. If you know how, its not a bad 
idea to tell the program you want some extra for the binding edge. But if you don’t know 
how, don’t worry about it.
The visual appeal and readability of your document will be enhanced by nice margins. Tight 
margins make the whole thing look cheap and crowded.

Quantity
The press schedules work flow using the size of a job to determine the amount of time it 
will take to print. We would like at least a good guess as to the number of copies you’ll need 
when beginning the Work Order. The final number can be changed up to the day they are 



printed. If we have already printed them and you want to reduce the number, you will be 
charged for the extras.

Visit the Press                                                                                             

Ask Questions
No question is too stupid to ask. Don’t be afraid to keep asking until you get a clear answer. 
If you don’t understand what we’re saying, there is a good chance we’re not understanding 
your needs any better.

Accepted File Formats
The University Press has the most common software programs. We have both Mac and PC 
computers. When in doubt, ask.

Preferred File Format
The print industry is moving more and more toward a pdf workflow.  (See The Joys of PDF 
under Digital Workflow.)

Time Frame
As a University Press we are obligated to put on campus work first. We do try to complete 
your job as soon as possible. Some times of year are naturally busier than others. When you 
visit the press or place your work order, ask how long we expect the job to take. Be sure to 
tell us your needs as well. We need to know if you want it in time for a family gathering.

Cost
There are many factors that determine final cost. Paper choices, number of pages, binding, 
and quantity are just a few.  Don’t rely on what your friend paid five years ago. You can 
receive an estimate on the price once the varying factors are known. 

Available Paper Choices
The first question involving paper choices is whether you want color or black and white 
pictures. At present, we are limited to just a few papers on the digital color press. There are 
several paper options available on the black and white printer. A conservative choice works 
best for family histories. 

Plan Ahead                                                                                              

Christmas Comes Early
If you intend to give your books to the family as Christmas gifts, be sure to plan ahead. 
September is not too early. July is even better. That will allow time for press proofs, binding, 
and Murphy’s Law. The bindery is especially busy before Christmas.



Family Reunion Time
Everyone plans their reunions for summer time when the kids are out of school. We try to 
stick to a first come, first serve order. So, come early and beat the crowd. If you have a hard 
deadline be sure to let us know up front. The good news is, late spring and early summer are 
not extremely busy times for on campus work and we will try our best to accommodate your 
needs.

Time Equals Money                                                                                  

Prepress Charges
There is a fixed rate charged for any time your book is worked on by prepress personnel. This 
cost is often the largest portion of your bill.

The more you do, the less we have to do.
Everything you can do to reduce the amount of time your project spends in prepress saves 
you money. An electronic file requires much less prepress time than scanning hard copies. If 
your book has very many photos, it will cost you less money to buy a scanner and learn how 
to use it, than to have the press scan them.  If you are not comfortable doing it yourself, we 
would be glad to help.

Proof Read Before You Take it to the Press
All spell checking and fact checking should be done before you bring it to the press. Minor 
changes can be made during the press proof stage, but it is in your best interests to avoid 
them whenever possible.

You Are Charged for All Proofs
A single proof is assumed and built into any initial estimate. You will also be charged for 
any additional proofs. Multiple changes and proofs slow down the entire process and make 
meeting your deadline much harder.

 
Cut and Paste

You may choose to create hardcopy pages by gluing or taping items to each page. It 
is possible for the press to scan these pages and create your book.  It is the most time 
consuming and expensive way and produces the poorest quality. Here are some reasons why.

Shadows from the Edge
Any item glued, taped or in any way physically stuck onto the page may scan with a line 
around it. This is caused by the shadow at the edge of the item. You may choose to simply 
accept the marks. Or, you may choose to have prepress clean it up for you. This option adds 
time and expense to your project.



Tape, Especially Old Tape
Even the clearest tape isn’t really invisible. When the light from the scanner hits it, it will 
reflect differently than the paper. The scanner may interpret this as an image and show it on 
the page. Old tape that has yellowed is especially bad.

Photographs are Different
Photographs must be scanned using different scan settings than text. (See the Scanning 
Basics  section.) Which means every one of your pictures must be scanned separately and 
then added back onto the page electronically. Time and money again.

Preservation
Please keep in mind that any glue or tape used on your photos and original documents has 
the potential to permanently damage them. Even Post It notes leave a residue that collects 
dirt.

Digital Workflow

Electronic Files
Electronic files are any documents generated on a computer. Word processing files, digital 
photos, scanned documents, & etc. are all electronic files. We use those files to print your 
book. A hardcopy, or non-electronic document must be scanned and saved as an electronic 
file before printing.

Better Quality
A document that starts as an electronic file prints with a higher quality than a scanned 
document, especially text. Photos printed on your home printer and then scanned will never 
have the quality of the original.

Less Prepress Time
A book brought to the press in digital format takes much less prepress time than a hardcopy.  
Remember, anything that saves prepress time saves you money.

Things we can do
We can combine multiple files into a single document. We can print divider pages on 
different papers. We can insert printed tabs into the document. We can print part of the 
pages on one color paper and part on another, or five others. We can add page numbers. We 
can white out existing page numbers, or anything else. We can put smaller items on the page 
more than once to save you money. We can paginate the document to make a booklet. We 
can resize pages. And the whole thing comes out collated, if we want it to.

The Joys of PDF
Platform Independent  PDF files created on a PC can be viewed and printed on a Mac, 
and vice versa. That makes it ideal for sharing and printing Family History information. You 
can print a pedigree chart from PAF and post it on a web page, email it to your cousin, or 
include it in your printed family history. Magic!



No Font Problems  A properly created PDF has all the fonts embedded. The press doesn’t 
need to have the font on their computers. Your cousin doesn’t need to have the font.
No Print Driver Problems  When the file is opened on other computers with other printers 
connected to them, nothing moves. The margins, lines, fonts, and page numbers are not 
rearranged to suit the other printer. Everything remains exactly where you put it. 
No Missing Pictures  Some programs only link pictures to the page. You have to include 
the picture files when you come to the press. A properly created PDF file has all graphics 
embedded eliminating that chore.
Table of Contents  Because nothing, including the page numbers will change, you can make 
your table of contents in advance rather than waiting until just before we print.
How to  Be sure you choose Press Quality on your settings when you make the PDF. 
Choose color only if you really want color, otherwise choose black and white.
CutePDF Writer & etc  Beyond a few programs that allow you to create a PDF from 
within, you will need software help to create a PDF. If you have the full version of Acrobat, 
not just the free reader, you can print a PDF from any program on the same computer. But 
Acrobat is expensive. You can create a PDF using an online conversion tool available at 
createpdf.adobe.com There are some smaller programs available that will let you create a PDF. 
A few are even free. One of them can be found at: www.cutepdf.com/Products/CutePDF/
Writer.asp  BYU-Idaho makes no guarantee of this or any other software and assumes no 
liability for any use of the same.

Scanning Basics

Get to know your software. Every scanner comes with scanning software. Some are more 
useful than others. If you are purchasing a new scanner, ask about the software.  Check 
Family History Magazine for scanner reviews. You need to be able to choose the resolution. 
You need to be able to switch easily between grayscale (black & white) and color. You need 
a bitmap or text setting if you intend to scan text. You need to be able to scan at higher 
percentages than 100% if  you want to enlarge small photos. Scan all photos at 300 dpi (dots 
per inch). If you intend to enlarge the picture, scan it bigger instead of enlarging after the 
scan. Scan text at 400-600 dpi. Anything higher just makes a huge file for no reason.
PhotoShop Elements is the best photo editing software you can get for under $100. Save the 
file as a tiff or tif, not a jpg.

Originals Are Always Best
Photocopies  Look at a photocopy of a picture with a magnifying glass. See the lines and/or 
dots? The scanner will see those.
Newspapers  Look at a news print of a picture with a magnifying glass. See the dots? The 
scanner will see those.
Home Printers  Look at a home print of a picture with a magnifying glass. See the lines 
and/or dots? The scanner will see those.
Preprinted (magazine, postcards, flyers)  Look at any printed picture with a magnifying 
glass. See the lines and/or dots? The scanner will see those. Also, be aware of copyright issues 



with preprinted material. You can’t use them in your book without written permission from 
the copyright owner. Yes, that includes church materials.
That’s a Moiré  Anything that starts out with lines or dots in it will probably develop a 
moiré pattern when it is printed. The printing process puts ink on as a series of dots. If those 
dots don’t line up exactly with the pre-existing dots (and they won’t) you get a moiré pattern. 
Have you ever seen a man on television with a loud tie that seems to jump and waver with 
every move? That’s a moiré! The pattern in the tie is at odds with the lines of the TV screen. 

It Won’t get Any Better
Examine the photo or document closely. It won’t get any better. Yes, there are some 
techniques we can use to improve some things. But once you place it in a Word document, 
those changes are limited to what Word allows. Word is not a photo editing program. If you 
want us to make any improvements to your old photos, let us do the scanning.

Grayscale
Photographs  If the photograph is black and white, scan it in grayscale. Scanning it in color 
increases the file size and can cause problems with some printing processes. If it is color but 
you intend for it to be printed as black and white, scan it in grayscale. You’ll be much happier 
with the finished product. 
There are some things other than photos you may need to scan in grayscale. If you see shades 
of gray in the image, it won’t work to scan it like text. See above.

RGB vs CMYK
Remember your science. Light is composed of red, green, and blue. (RGB) White is all light 
spectrums together. Black is the absence of light. Digital cameras capture light, and lack 
of light. All files from a digital camera will be in RGB mode. Scanners (and color copiers) 
capture the image using light and create RGB files. Some more expensive scanners will 
convert to CMYK.
CMYK stands for cyan, magenta, yellow, and black. They are ink colors. High end presses 
combine cymk inks to print every color in your photo. If you intend to print something in 
color, and you have scanning or photo editing software that allows you to convert to cmyk, 
do it. If not, consider giving us the color scans and letting us convert them to cmyk for you 
before you place them in Word or similar program.
Many people are satisfied with the conversion of their snapshots by the digital press. There is 
usually very little color shift. The most common problem is a slightly flat appearance.

Bitmap
Bitmap is the mode used for straight text. There are no shades of gray. Every pixel is either 
black or white. If you are old enough to remember the very first Xerox copiers, you’ll be able 
to imagine what that this setting does to photos.

Scanning Do’s and Don’t’s 
Plastic Sleeves  Always remove things from any plastic sleeve. You will not be happy with 
the scan otherwise.
Glue and Tape  The wrong kind of glue will cause ripples in paper. You’ve seen it. The 
scanner will see it. Even if you can’t see the “invisible” tape, the scanner might. Try to avoid 
these sticky problems.



Sparkle and Shine  There are some very pretty stickers in the scrapbooking section of the 
store. They sparkle and shine and reflect the light from the scanner and ruin your scan. 
Anything foil, iridescent, or glittery will scan as a black blob.
Red and Yellow  In grayscale, red scans as black, pure yellow vanishes. A flag sticker with 
gold fringe will scan as black stripes and no fringe. 
Speckled & Colored Paper  Even when scanning text in bitmap mode, the color of paper 
your original document resides on effects the outcome. As with ink (see above) red paper 
scans as black. So do purple and orange to some degree because they have red in them. Blue 
and green paper turns gray in grayscale mode and just looks dirty if scanned in bitmap. The 
good news is that yellow paper and yellow highlight marker disappears just like yellow ink. 
Speckled paper leaves, you guessed it, speckles.

Potential Problems

Incompatible Software
We will still try to open your files even if we do not have the same software you used to 
create them. There are likely to be problems with the layout of the document even if we get it 
open. Check with the press before you begin your project  to avoid this problem.

Printer Drivers
Windows operating system uses tiny computer codes called print drivers to format your page 
to suit the printer plugged into your computer. When you save a file on a cd and open it on 
another computer with a different print driver, the software repositions everything to suit 
the new printer. This can cause unexpected and unhappy things to happen to your book. One 
thing you can do to lessen the impact is to use hard page breaks. Don’t just hit the enter or 
return key over and over to move to the next page. Insert a hard page break.  It is found on 
the Insert menu in both Word (Break) and WordPerfect (New Page). Also, consider the Joys 
of PDF in the Software Choices section.

Fonts
If we don’t have the font you used, many programs will use the default font Courier. 
Courier is the ugliest font on the planet. The two easiest ways to avoid 
this is to either use a common font such as Times New Roman, or save your document as a 
pdf. (See The Joys of PDF in the Digital Workflow section.)

Missing Pictures
Some programs allow you to link a picture to the page in a picture box rather than 
embedding it in the document. The advantage is that it creates a much smaller file. The 
disadvantage is that you must bring all those picture files with you to the press. Without 
them we cannot go ahead with the printing. If the final file is saved as a PDF, all the pictures 
come along for the ride. (See The Joys of PDF in the Digital Workflow section.)

Huge Files—Break It Up
The larger the file, the more likely it is to slow your computer down. The older your 
computer, the more true that is.  Break the book up into separate files for each chapter. Call 



each file chapter1, chapter2, & etc.. That way you will have a much easier time working with 
them. And since they are clearly labeled 1,2,3, they will be easy to assemble at the press.

Save Often
You’ve spent years working on this project. Research. Gathering photos. Proofreading. 
Double and triple checking everything. Then the thunder rumbles and your power goes out 
and the last ten pages are gone. Save often! Save every time you stop to think about what to 
say or do next. Save when someone interrupts you. Save whenever you think of it. 

Make a Backup Copy
Or worse, your computer crashes and the whole book is gone. Make a backup copy every 
once in a while, burn it on a cd, and keep it somewhere else in the house, or even someone 
else’s house or at work. The more changes you’ve made the more you need to make a new 
backup copy.

Proof Reading
There is no way to get something that big perfect. It won’t happen. Addendum to Murphy’s 
Law: You’ve sweated bullets to get everything right and take the finished copies to the family 
reunion. The first person to open the book will find a mistake. Have at least one other person 
proof read for you before you bring it to the press. 

Software Choices

Microsoft Word
1-1.5” Margins  Word starts every document with one inch margins on the top and bottom 
and 1.5 inches on the left and right edges. That’s plenty for all types of binding we offer.
Insert Page Break  When you get to the end of a chapter and want to start the next 
paragraph on the following page, please don’t hit the enter or return key over and over until 
the curser moves to the next page. Insert a page break. Go to the Insert menu at the top 
of the program. Choose Break. Choose Page. Multiple returns often shift when the file is 
opened on another computer.
Binding Edge  If you are having your history spiral bound you may add an extra quarter 
inch on the inside edge. If you have kept the default margins, it isn’t really critical. You’ll 
be OK without it. If you are having your history three hole punched, you may want to add 
another half inch to the inside edge.  Your text will look more centered on the page. But if 
you kept the default margins the holes won’t go through any text, so you’ll be OK either way.  
If you are having your history perfect bound, like a paper back book, you must leave at least 
a one inch margin on all sides. After the inside edge is glued into the cover, the other three 
edges are trimmed to make a smooth, even edge.  If you are having your book hard bound, 
you will want a half inch more on the inside edge.  To add a binding edge in Microsoft 
Word, go to the File menu at the top of the program. Choose Page Setup. In the middle of 
the Margins window it has an option for multiple pages.  Choose Mirror Margins from that 
list. Now look above that area. You can increase the size of the inside margin by the needed 
amount.



WordPerfect
1” Margins  WordPerfect starts every document with one inch margins on all sides. That’s 
enough for all types of binding we offer.
Insert New Page  When you get to the end of a chapter and want to start the next 
paragraph on the following page, please don’t hit the enter or return key over and over until 
the curser moves to the next page. Insert a page break. Go to the Insert menu at the top of 
the program. Choose New Page. Multiple returns often shift when the file is opened on 
another computer.
Binding Edge  If you are having your history spiral bound you may add an extra quarter 
inch on the inside edge. If you have kept the default margins, it isn’t really critical. You’ll 
be OK without it. If you are having your history three hole punched, you may want to add 
another half inch to the inside edge.  Your text will look more centered on the page. But if 
you kept the default margins the holes won’t go through any text, so you’ll be OK either way.  
If you are having your history perfect bound, like a paper back book, you must leave at least 
a one inch margin on all sides. After the inside edge is glued into the cover, the other three 
edges are trimmed to make a smooth, even edge.  If you are having your book hard bound, 
you will want a half inch more on the inside edge.  To add a binding edge in WordPerfect, go 
to the Format menu at the top of the program. Choose Page and Page Setup. At the top of 
the window that comes up are two tabs. Go to Layout. Under two sided printing click on the 
option for Book.  Move down to two sided binding. The margin it expects you to increase 
there is for the inside edge. 
Will Create PDF File  One of WordPerfect’s best ideas was to allow you to save your 
document as a pdf file. (See The Joys of PDF in the Digital Workflow section.) Go to the 
file menu.  About half way down it says Publish to. Choose PDF. It will ask where you want 
it saved and what the name of the file should be. Easy! One caution. Open the pdf after you 
have saved it and check each page for formatting problems. WordPerfect recognizes this as 
a different print driver. It may shift things around on you. Unfortunately, if you do not have 
any kind of printer plugged into your computer, this option will not work.

Microsoft Publisher
Pagination  Publisher has a few printing options that allow pagination. Pagination is the 
placing or rearranging of pages for print. The press has software that does that easily. If you 
don’t know exactly what you are doing, please leave this to us.
1” Margins  Publisher starts every new document with a blue line indicating one inch 
margins on all sides. You can follow that box with your text box or not as you wish. That’s 
enough space for all types of binding we offer.

Adobe Indesign
More Expensive  InDesign is part of Adobe’s Creative Suite (CS) that includes Photoshop, 
Illustrator, and other programs. It can also be purchased alone.
More flexible  It is a higher end program than Word or Publisher. It’s target user is the 
design and printing professional. Don’t let that scare you away though. If you plan on doing 
several books, or if your project is complicated, and if your budget can stand it, it may be 
worth the investment. There is a learning curve, but there are also dozens of printed books 
about it.



Will Create PDF File  InDesign will save your finished document in PDF format. That 
eliminates font and picture issues. (See The Joys of PDF in the Digital Workflow section.)

Adobe PageMaker
PageMaker has been replaced in the Adobe family by InDesign and is no longer being 
updated. If you already have a copy and want to use it, please see the Joys of PDF in the 
Digital Workflow section for instructions on how to save your document as a PDF.

QuarkXpress
Quark is a professional typesetting program. It is used by newspapers, magazines, yearbooks, 
and publishers. If you already own a copy, by all means use it.
Font Issues  At the press, our copies of Quark are all Mac format. If you have used a 
windows versions of Quark to make your book, the file can be opened on a Mac, but the 
fonts may not translate. Your best bet is to print the final document as a PDF.  (See The Joys 
of PDF in the Digital Workflow section.)

Suggested Paper Choices

Insides
24# laser (B&W Printer)  This is a slightly thicker paper than the usual copier/printer paper. 
It is a brighter white and feels smoother to the touch. The extra thickness helps keep the 
pictures from showing through on the other side of the page.
80# matte (Color Press)  The digital color press uses special paper. The text weight is a 
very nice paper for both text and pictures. It comes in gloss and matte finishes. We don’t 
recommend the gloss for books. You don’t want glare on a page you’re trying to read.
Mix & Match  It is possible to have us print most of the book on the black and white 
printer and then insert the pages that were printed in color on the digital press. The two 
papers mentioned above are not exactly alike, but they go together nicely.

Soft Covers
Cardstock  If you are having your book spiral bound, perfect bound, or three hole punched, 
we have several nice cardstock weight papers in stock you can choose from. We can special 
order paper if you have something else in mind. Any of these can be printed on by the black 
and white printer.
Cover  Cover weight is slightly heavier than cardstock. We carry some very nice choices. 
They will work for any of the binding options above.
Color Covers  A book looks very nice with a cover printed in color. It is more expensive 
than black and white but the result may be worth it to you.



Bindery Options

Three Hole
There are several reasons you may want to put your family history book in a binder. You can 
add new information. You can place it in a standard Book of Remembrance. And it is the 
least expensive option we offer.

Spiral Bind
We use a plastic spiral that wears well and doesn’t snag your clothes like the metal spirals 
you remember from grade school. The cover can be of any of the cardstock or cover weight 
papers. We can print on either side of either cover.

Saddle Stitch
A magazine with staples in the spine is saddle stitched. We take large sheets with four pages 
printed on each, two side by side on the front and two side by side on the back, fold it in half 
and put staples in the spine. This option is only good for small projects. Our booklet maker 
will only handle 21 sheets easily. So, 20 x 4 = 80 pages plus a cover. We can print on the 
inside and back of the cover.  Sizes can be 5.5x8.5 to 8.5x11. We offer a square back option 
as well.

Perfect Bound
A paperback book is perfect bound. Covers can be on the cardstock or cover weights or you 
may choose colored pictures on the cover.

Hard Bound
We have a standing relationship with a bindery in Utah. We print the book and then ship it 
to them to be hard bound. This is the most expensive and most time consuming option. If 
you need it by a specific date, please plan ahead.


